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第一章    使用 Saber Designer创建设计 
 

本教材的第一部分介绍怎样用 Saber Design创建一个包含负载电阻和电容

的单级晶体管放大器。有以下任务： 

*怎样使用 Part Gallery来查找和放置符号 

*怎样使用 Property Editor来修改属性值 

*怎样为设计连线 

*怎样查找一些常用模板 

在运行此教材前，要确认已正确装载 Saber Designer并且准备好在你的系

统上运行（找系统管理员）。 

注： 
对于 NT鼠标用户：两键鼠标上的左、右键应分别对应于本教材所述的

左、右键鼠标功能。如果教材定义了中键鼠标功能，还介绍了完成该任务的替

代方法。 

 

一、创建教材目录 

你需要创建两个目录来为你所建立的单级放大器电路编组数据。 

1. 创建（如有必要的话）一个名为 analogy_tutorial的目录，以创建教材实

例。 

2. 进入 analogy_tutorial目录。 

3. 创建一个名为 amp的目录。 

4. 进入 amp目录。 

二、使用 Saber Sketch创建设计 

在这一部分中，你将使用 Saber Sketch设计一个单级晶体管放大器。 

1. 调用 Saber Sketch（Sketch），将出现一个空白的原理图窗口。 

2. 按以下方法为设计提供名称 

3) 通过选择 File＞Save As ⋯菜单项，存储目前空白的设计。此时将出

现一个 Save Schematic As对话框，如图 1所示。 



 2

 

图  1 

 
 

2) 在 File Name字段输入名称 Single_amp。 

3) 单击 OK。 

3. 检查 Saber Sketch工作面 

1) 将光标置于某一图符上并保持在那里。会显示一个文字窗口来识别该

图符。在工作面底部的 Help字段也可查看有关图符的信息 

2) 注意有一个名为 Single_amp的 Schematic窗口出现在工作面上。 

 

三、放置部件 

在教材的这一部分你将按图 2所示在原理框图上放置符号。图中增加了如

r1、r2等部件标号以便参照。 
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图  2 单级晶体管放大器部件布局 

 

1. 按以下方式查找和放置 npn 晶体管符号： 

1) 单击 Parts Gallery图符 出现 Parts Gallery对话框，如图 3

所示。 

 
图 3  Parts Gallery对话框 

2) 设置以下 Parts Gallery字段： 

Category Name（目录名） ／ 

Search String（查找串） npn 

Available Categories  在本教材此项均不用选。 

3) 选择 Options＞Preferences菜单条目。出现 Parts Gallery 

references格式的窗口。 
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4) 单击 Search 标签并选择设定值如下： 

Search part by   Part  Name 

Search match   Containing 

gnore Case When Doing 在本教材此项均选择 

Search （搜寻时忽略大小写） 

5) 单击 OK。 

6) 在 Parts Gallery中，单击 Search键。 

所有含有“npn”的部件说明清单将出现在 Available Parts表中。 

7) 在 Available Parts表内，选择 BJT，NPN 3 pin。 

8) 通过单击 place按键放置 npn符号。 

2. 按以下方式查找并放置 5只电阻符号： 

1) 在 Parts Gallery中，字段设置如下： 

 Category  Name   ／ 

 Search  String   res 

2) 选择 Options＞Preferences菜单条目。出现 Parts Gallery 

Preferences格式的窗口。 

3) 单击 Search 标签并选择设定值如下： 

Search part by   Part  Name 

Search match   Beginning with 

4) 单击 OK。 

5) 在 Parts Gallery中，单击 Search按钮。 

6) 在 Available Parts表中，选择 Resistor（1）。 

7) 单击 place按钮 5次来放置 5个电阻。 

8) 通过单击 Saber Sketch Icon Bar 中的 Toggle Grid图符 ，在原理

图窗口中打开网格。 

9) 将 5个电阻按图 2所示放置在晶体管周围，步骤如下： 

*一一将鼠标光标放置在每个电阻上。 

*按下并保持鼠标左键。 

*将部件拖至合适的位置并释放鼠标。 
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10) 在 Saber Sketch Icon Bar中，单击 Zoom to Fit图符 ，使用

Zoom图符来处理显示内容的大小。 

3. 使用下列 Parts Gallery设定值及图 2所示的部件布局图来查找并放置

V_Pulse符号。 

Category Name 

Search    String  V_Pulse 

1) 选择选择 Options＞Preferences菜单条目。出现 Parts Gallery 

Preferences格式程序。 

2) 单击 Search标签并选择设定值如下： 

Search part by  Symbol  Name 

Search match  Beginning with 

3) 单击 OK。 

4) 在 Parts Gallery中，单击 Search按钮。 

5) 在 Available Parts表中，选择 Voltage Source, Pulse。 

6) 单击 place按键放置 V-Pulse符号。 

4. 使用下列 Parts Gallery设定值查找和放置 V_dc符号： 

Category  Name  ／ 

Search  String  V_dc 

1) Parts Gallery Preferences表格中参数设定值同上。单击 Search按

钮 

2) 在 Available Parts 表中，选择 Voltage Source, Constant. 

单击 Place按钮放置 V_dc符号。 

 

5. 按以下方式查找和放置水平电容符号： 

                Category  Name  ／  

                Search    String  cap 

1) 选择 Options＞Preferences菜单条目。 

2) 单击 Search 标签并选择设定值如下： 

         Search part by  Part  Name 

         Search match  Beginning with 
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3) 单击 OK。 

4) 单击 Search按键。 

5) 在 Available Parts表中，选择 Capacitor（一）。 

6) 单击 place按键放置 C符号。 

7) 如图 2所示放置符号。如下可旋转符号 180°。 

* 将光标移至符号上以便选择该符号。 

  * 按下并保持住鼠标右键以便引出上托符号菜单。选择 Rotate＞180菜单

条目并释放鼠标键。 

        * 根据需要对符号重新定位。 

6. 按以下方法查找并放置直立电容符号： 

1) 在 Parts Gallery 中，使用 3.5 节中所作的相同设定值，只是在

Available Parts表中，选择 Capacitor（1）。 

2) 如图 2所示放置和定位符号。 

7. 使用以下 Parts Gallery设定值查找并放置 6个接地符号： 

                    Category  Name  ／  

                    Search    String  ground 

1) 选择选择 Options＞Preferences菜单条目。 

2) 单击 Search 页签并选择设定值如下： 

             Search part by  Part Name 

             Search match   Beginning with 

3) 单击 OK。 

4) 单击 Search按键。 

5) 在 Available Parts清单中，选择 Ground(Saber Node 0)。 

6) 通过单击 place按键 6次放置 gnd符号。如图 2所示布置符号。 

8. 使用以下 Parts Gallery设定值查找并放置 3个 VCC符号： 

                     Category  Name  ／  

                     Search    String  vcc 

1) 上次搜寻中使用的 Parts Gallery Preferences表格设定值将作用于此

次搜寻。单击 Search按键。 

2) 在 Available Parts表中，选择 VCC。 
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3) 单击 Place按键 3次来布局 VCC符号。如图 2所示布置符号。 

4) 关闭 Parts Gallery。 

 

四、编辑符号属性 

一旦所有部件均在原理图上布局，你可在每个符号上设定本设计专用的属

性值。图 4表示了要用的一些参数。 

 
图 4  单级晶体管放大器符号属性值  

 

 

1. 对于那些属性值为（*opt*）并已被显示的符号(如电阻和电容符号)，你

可按以下方法更改每个值： 

1) 将光标放在所需字段的端部。 

2) 单击鼠标左键。 

3) 在现有文字上后移一格（用后移键）将其删除。 

4) 键入新文字。 

5) 例如，将光标放在图 4中所示 rload字段的端部，并用 10k替换

*opt*。 

6) 对于下列元件，重复 a～d步骤。 

r1  61K 
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r2  17.6K 

re  300 

rc  1.1K 

cin  33n 

cload  0.1n 

当你需要更换看不见的属性值时，你必须使用下一步所述的 Property 

Editor。 

2. 改变 V_dc符号属性，实施以下步骤： 

1) 将光标放在 V_dc符号上以选中它，改变色彩表示它已被选中。还要

注意在底部的 Help字段中，会显示符号名称（V_dc），以及实例号

（如—7）。 

2) 按鼠标右键并保持。出现上托 Symbol Menu 菜单。 

3) 在 Symbol Menu 菜单中，将光标在 Properties…条目上并松开鼠

标。 

会 显 示 Property Editor 对 话 框 。 注 意 , 由 于 设 定 了 Visibility 

Indicators(Vis)，因而可为一些属性显示值。通过多次点击这些指示器，并根据

原理图窗口显示的情况，设置指示器, 如图 5所示。 

 
图 5    属性框 

4) 在 Property Editor对话框中，将 ref属性改为 VCC。 

5) 将 dc_Value属性改为 12，默认为 V。 

6) 在 Property Editor对话框中，单击 Apply键。 
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3. 改变其余符号的属性，对于列在对应表格中的每个符号重复下列步骤： 

1) 每次选择一个符号（用鼠标左键单击符号） 

2) 如表一所示填充 Property Editor对话框中的字段。表格中的符号参

数值对应于图 4所示的参考值。在改变参考值以前，它们已具有 ref

值如 v1,res1,c1等。如果在 Property Editor 中出现的参数在表中未

列出，请不要改变它的内定值。 

3) 完成对每个符号的特性值的输入后，单击 Apply 按钮。单击 Property 

Editor对话框（顶部）的 Help按钮，可获得关于所选符合的一些特

性的详细说明。如有必要可使用滚动杆查看未显现的附加特性表。 

表一 

 

4. 关闭 Property Editor对话框 

符 号 参 考 属 性 名 值 

ref Sig_source 

initial 1.2 

pulse 2.3 

tr 10n 

tf 10n 

width 0.5u 

period 1u 

v.sig_source 

ac-mag 1 

ref q1 q_3p.q1 

Saber_model (type=n,bf=200) 

r.r1(61k) ref r1 

r.r2(17.6k) ref r2 

r.rc(1.1k) ref rc 

r.re(300) ref re 

r.rload(10k) ref rload 

c.cin(33n) ref cin 

c.cload(0.1n) ref cload 
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五、连接原理图 

在布局完符号并设定了属性后，你可以如图 6所示将部件连接在一起。 

 
 图 6  单级晶体管放大器连线 

 

在以下步骤中，除非有指示，否则不要在 cin、q1、r1和 r2的相交处连

线。 

1. 在两个端口间连线的最简单的方法如下： 

1) 将光标放在第一端口上面（以 V_dc符号的顶部开始）。 

2) 单击鼠标左键。 

3) 将光标放在第二个端口上（VCC符号在 V_dc符号的上面。 

4) 再次单击鼠标左键。 

5) 重复步骤 a～d，从而将每个接地和 VCC符号连至相关部件，如图 6

所示。 

2. 采用 5.1中的步骤，连接 cload至 rc。注意在 cload符号附近会形成一

个直角。按如下方法你可以重新布置任意一段导线： 

1) 将鼠标移至你想要移动的导线段。 

2) 按下并保持鼠标左键。 

3) 将导线段拖至理想的位置。 

4) 松开鼠标。 

3. 将 rc连至 q1集电极。 
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4. 将 re连至 q1发射极。 

5. 将 rload直接连至由 cload－rc连接形成的导线。 

6. 将 sig_source连至 cin。如果需要，移动导线段。 

7. 将 q1的基极连至 cin。参考图 6。 

8. 要将 r1和 r2连至 q1-cin的相交点，你必须画两条线，一条从 r1至相交

处。一条从 r2到相交处，如果你从 r2至 r1画一条线，那么在 cin-q1相

交处则没有连接点。 

 

六、修改导线标记属性 

如果你不标记导线，Saber Sketch自动为每根线提供名称，例如_n30。如

果你用一个便于阅读和理解的命名来标记导线，这对于将来的设计分析是有用

的，如图 7所示。 

 
图 7  单级晶体管放大器导线标记 

 

与 vcc或地相连的导线由 Saber Sketch分别用 vcc和 gnd标记。没有必要

改变这些标号。 

要增加图 7中所示出的 4个导线标记的话，可按以下步骤进行： 

1. 对于第一个导线标记，将光标移至所要的导线并使其改变颜色。 

2. 按下并保持鼠标右键以显示弹出菜单Wire Menu。 

3. 在弹出菜单Wire Menu 中，选择 Attributes⋯条目并释放鼠标。显示

Wire Attributes对话框。 
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4. 将 Name字段中的值改成理想的文字串，参看图 7。 

5. 在Wire Attributes对话框中，在 Display Name字段单击 Yes。 

6. 单击 Apply按键。 

7. 将光标移至下一根要改名的导线上并单击鼠标左键。现有导线名出现在

Wire Attributes对话框 Name字段中。  

8. 重复 6.4—6.7的步骤；直至完成导线标记的修改。 

9. 关闭Wire Attributes对话框。 

10. 单击 Save图符以保存设计 。 

此时，你已拥有一个可用于分析的完整设计。在教材的下一章节，你将使用

Saber Guide来仿真放大器。 

 

七、常用模板（templet）应用 

1. 磁性器件(Magnetic) 

磁性器件有很多，我们这里主要讲述 Magnetic core、Winding及变压

器。 

查找路径：MAST Parts Library/Magnetics(可直接输入名称查找)打开此

路径，左边 Available Categories 栏下还有不同的子路径，右边的 Available 

Parts栏下有 Magnetic 模板(如 Magnetic core、winding等)。 

不同的模板，它的属性也不同，所要修改的参数也不同，我们在这里介绍

最基本的参数。比如线性磁芯(Magnetic core，linear)，它的属性框中的参数有

很多，但最基本的参数却很少。它的填写方法有两种：第一种是只需填写磁芯的

电感量(al)；第二种是填写磁芯的长度、面积和磁导率(len、area、ur)，如果磁

导率使用默认值 1，那幺它只是代表磁芯的空隙。又如线圈(winding)我们只需填

上匝输 n就可，当然其它参数(面积、电阻)，越详细越好。 

我们知道变压器也是一种磁性器件，是电源中不可缺少的器件。在 Saber

的 Library中提供了三种类型五种型号的变压器模板。三种类型分别为：1)、DC 

2)、linear 3)nonlinear。五种型号分别为：Two-winding；Three-winding；four-

winding；five-winding；six-winding。 

查找路径：MAST Parts Library/Magnetics/transformers(也可直接输入

transformer查找) 
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三种不同类型的变压器所需的基本参数也不同，在 DC变压器中只要定义

输入输出匝数；在 linear变压器中有两种提供参数的方法：第一种是提供电特

性，即输入输出端的电感量(lp、ls)，第二种是提供磁特性，即输入输出端的匝

数、磁芯长度、面积和磁导率(np、ns、len、area、ur)；在 nonlinear变压器中

要定义输入输出端的匝数(np、ns)、电阻(rp、rs)及磁芯的长度和面积(len、area),

最好提供磁芯的磁矩回线所需的各种参数。(这里都是以 Two-winding为例) 

2. 电压源的查找(source) 

在 Saber的 Library中，source的种类也有很多，但最常用的是电压 Saber

中的电压源有直流源(v_dc)、脉冲源(v_pulse)、正弦波电压源 (v_sin)、分段线

性电压源(v_pwl)和 v_trpf。 

查找路径：MAST Parts Library/Electrical/Electrical sources/Voltage 

sources(可直接输入 source查找) 

在电压源的属性框中都有标有*rep*的属性栏，这表明此属性值必须由设计

者自己提供，其它参数根据需要提供。 

3. Averaged Model的查找 

Averaged Model 是 Saber 仿真软件所提供的一种独特的 Model，主要是

用来帮助设计反馈补偿电路的。 

查 找 路 径 ： MAST Parts Library/Electronic/Analog Ic/PWM Avg, 

Continuous. 

Saber 的 library中有多种 Averaged Model，我们现在主要介绍一下在电

源 Demo中用到的一个 Model(PWM,Forward 2 Switch CVM)，它是一个集

PWM、变压器及开关功能于一体的 Model。 

它需要设计者输入的属性有最小占空比 (dutymin)和最大占空比

(dutymax)(它们取值范围是 0~1 之间)；对应于最小占空比和最大占空的控制电

压(cntlmin 和 cntlmax)，它们的值是 2.5*占空比；变压器的输入输出匝数比

(n)；二极管导通电压(von)、导通电阻(rd)和关断电阻(roff)。 

4. 补偿器(compensator)的查找 

在设计中尤其是电源设计中我们经常遇到反馈回路的设计，由于引入了回

路控制，就会增加电路的不稳定性，这样我们必须对电路进行补偿。在 Saber

中有各种传递函数的补偿器供设计者使用。 
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查找路径：MAST Parts Library / Electronic / Ideal / Poles & Zeros / 

Compensators(也可以直接输入 compensator查找)。 

补偿器的属性参数值的设定有两种方法：第一是确定传递函数的增益

(k)、传递系数(w1,w2….)和直流电压的偏移(dcoff)；第二是确定等效电路的电

阻和电容值。 

5. 连接器(connector)的查找 

在设计中我们会经常用到 Top-Down设计，在一张图纸画不下所有电路图

时，也会用到 Multi-Sheet(使用多张原理图)，遇到这些情况时，我们就要在原

理图上加上连接器(connector)。在 Saber里有许多的连接器。 

查找路径：MAST Parts Library/Schematic Only/Conncetors，无需参数

设置。 
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第二章    Saber scope的介绍 
 

Saber Scope是一个混合信号图形化波形分析器，它是 Saber Designer

的一个独立模块，包含 50多种分析，70多种测量。能对仿真结果进行波形显

示，并对波形进行分析和测量。教材本部分主要完成以下内容： 

*Scope Overview 

*如何使用信号管理器 (Signal Manager) 

*如何使用波形计算器 (Waveform Calculator) 

*如何使用测量工具 (Measurement Tool) 

注： 
对于 NT鼠标用户：两键鼠标上的左、右键应分别对应于本教材所述的

左、右键鼠标功能。如果教材定义了中键鼠标功能，还介绍了完成该任务的替

代方法。 

 

一、Scope Overiew 

启动 Saber Scope(Unix环境中直接输入 Scope启动)，会出现一个空白

图形窗口，如图 8所示： 

 

 
图 8  
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Scope 窗口的菜单下面是它的图标栏，如图 9所示： 

 

 
图 9 图标栏 

 

在 Scope 窗口底下有一条工具栏，如图 10所示： 

 
图 10    工具栏 

二、信息管理器 

从下拉菜单中选择 Tools>Signal Manager或者用鼠标左键单击工具栏中

的 图符就会弹出信号管理器对话框，如图 11所示： 

 

 
图 11 
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1) 从信号管理器对话框中选择 File>Open Plotfiles…或者用鼠标左键单

击对话框右边的 Open Plotfiles…图标就会弹出复选框，你就可以选

择你所要的目录下的文件。 

2) 执行以上操作后，在信号管理器的 Plotfiles栏会出现你所选上的文

件，并弹出该文件中的所有信号，如图 12所示： 

 
图 12 

选上你所要观察的信号并双击鼠标左键或者用鼠标左键单击 Plot，该信

号就会以图形方式显示在 Scope图形界面中。 

三、计算器（Calculator） 

从 Saber Scope 窗口的下拉菜单中选择 Tools>Calculator或者用鼠标左

键单击工具栏中的 图符就会弹出计算器窗口，如图 13所示： 

 
图 13 

Misc: 完成一些数学、向量、矩阵运算 (abs mod round等) 

Wave: 执行一些波形操作 (FFT IFFT f(x) Histogram等) 
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Cmplx: 完成一些复数运算 (complex real imag等) 

Logic: 执行逻辑运算 (与 或 非等) 

Trig: 完成一些三角运算 (sin cos tag等) 

Stack: 管理堆栈寄存器 

详细功能解释请看附录二。 

四、测量工具（Measurement Tool） 

Measurement Tool 也是 Saber Scope 中的一项重要功能，通过选择

Saber Scope窗口的下拉菜单 Tools>Measurement或者用鼠标左键单击工具栏

中的 图符就会弹出测量工具窗口，如图 14所示： 

  
图 14   

在图 14 中，用鼠标左键单击 Measurement 栏右边的箭头，就会弹出

General、Time Domain、levels、Frequency Domain、S Domain、Statistics

六大类 50 多种测量选项。用鼠标左键单击 Signal 栏右边的箭头可以选择你所

要测量的信号。 

General: At X value, At Y value, Delta X, Delta Y, Length, Slope, Local 

Max/Min, Crossing, Horizontal level, Vertical level, Point Marker 

Time Domain: Falltime, Risetime, Slew rate, Period, Frequency, Duty 

Cycle, Pulse Width, Delay, Overshoot, Undershoot, Settle time 

Levels: X at Maximum, X at minimum, Peak to Peak, Topline, Baseline, 

Amplitude, Average, RMS, AC Coupled RMS 
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Frequency Domain: Lowpass, Highpass, Bandpass, Stopband, Gain 

margin, Phass margin, Slope, Magnitude, dB, Phass, Real, Imaginary, Nyquist 

Plot Frequency 

S Domain: Damping Ratio, Natural Frequency, Quality Factor 

Statistics: Maximum, Minimum, Range, Mean, Median, Standard 

Deviation, mean +3 Standard Deviation, Mean –3 Standard Deviation, Yield, 

Dpu, Cpk 

详细解释请看附录一。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 20

第三章    使用 Saber Designer分析设计 

一旦用 Saber Sketch 创建了一个可用于仿真的设计，你便可以进入

Saber Guide Simulation Environment分析设计。 

教材的本部分，将使用 Saber Guide来分析你用 Saber Sketch创建的单

级放大器设计。步骤如下： 

*怎样执行瞬态分析，这种分析可自动实施必要的 DC分析。 

*怎样完成小信号频率分析。 

*怎样改变输出负载并分析结果。 

*怎样布置测试器并在原理图上观察仿真结果。 

*怎样用 Scope测量和分析波形 

一、从 Saber Sketch环境中启动 Saber Guide 

在下面的步骤中，你将从 Saber Sketch启动 Saber Guide，Saber 

Sketch中已经打开了单级放大器设计： 

1) 通过单击 Saber Sketch中的 Show/Hide Saber Guide图符 来显

示 Saber Guide 图标条。  

2) 1.2 通过单击 Simulation Transcript图符 打开 Saber Guide 

Transcript窗口。 

 
  图 15 

 

Saber Guide Transcript窗口含有所有命令执行的结果。 
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二、执行瞬态和 DC分析 

在本教材的这一部分中，将完成瞬态分析，并用 Saber Scope显示结果

来检查输出信号波形。 

在执行瞬态分析之前，找出电路的 DC工作点非常重要。DC工作点在瞬变

（时域）分析中用作第一数据点。DC分析从 Time-Domain Transient (tr) 

Analysis（时域瞬变分析）对话框开始。 

分析前，须为设计创建一个网表。当你开始瞬态分析前，它会自动完成。 

1) 单击 Transient Analysis图符 以调出 Time-Domain Transient 

Analysis对话框。会显示 Basic图表。 

2) 如下填好图表： 

End Time  100u 该值提示 Saber仿真电路 100us 

Time Step  0.1u 该值给 Saber 一个时间增量，以便开始解答

电路 

Run DC         

Analysis First Yes 在瞬变分析可计算之前须确定 DC工作点 

3) 在本教材的后面你还将用到这些瞬变分析设置值，因此要按下列方法

将它们存储： 

4) 在 Time-Domain Transient Analysis对话框中，单击 Defaults会出现

如下的 Set up for tranalysis对话框： 

 
图 16 

5) 在 set up for tranalysis对话框的 Tag Name字段中输入单一名字

amp_tr。 

6) 选择 Current标签，单击 Set Tag。 
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Amp_tr 标签名被加进 Tags 表中，并且你在 set up tranalysis 对话框中

输入的值会出现在 Form Value表中。 

7) 仍在 set up for tranalysis对话框中，单击 Apply。  

8) 在 Time-Domain Transient(tr) Analysis 对话框中，单击 OK。 

9) 会显示一个 Yes or No对话框来提示你在建立网表之前须保存单级放

大器设计并询问你是否要继续。单击 Yes。网表启动。 

如果你离开操作，在 Time-Domain Transient(tr)Analysis 对话框中输入

的值不会保存。要完成 save-on-exit的话，选择下面 Saber Sketch窗口菜单条

目： 

File＞Configuration＞Save on Exit 

4. 观察 Saber Guide Transcript窗口 

文本窗口显示许可证信息，以及网表完成后执行的特殊命令。你可以卷动

窗口来察看文本。该窗口首先显示正在使用的 Saber版本、许可证资料以及本

设计所用的模型等信息。 

还显示 DC 分析执行时间。在这一步中，你没有填充 Operating Point 

Analysis 格式程序，因此使用默认设定值来确定设计中每个结点的 DC 值。在

多数情况下，Saber仿真器使用在 Operating Point Analysis格式程序中的默认

设定值来寻找工作点。创建一个带.dc 扩展名的文件来保留分析的结果。如果你

想要显示 DC分析结果，则执行下列步骤： 

1) 在 Saber Sketch窗口中，选择 Results＞Operating Point Report⋯菜

单条目来显示 Operating Point Report对话框。 

2) 在 Operating Point Report对话框中，单击 OK。它通知 Saber使用

默认设定值在 Report Tool窗口中显示最近的 DC工作点值，如图 17

所示。 

3) 参考 Report Tool窗口中的 DC结果及原理图来协助分析结果。如有

必要，你可重新设置窗口尺寸或使用卷动杆来察看所有结果。结果还

显示在 Saber Guide Transcript窗口中。 

4) 关闭 Report Tool窗口。 
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图 17    直流工作点分析结果 

在执行第 a-c步前，瞬变分析执行时间显示在 Saber Guide Transcript窗口

中，表明瞬变仿真已完成。创建一个带.tr扩展名的文件来保存瞬变分析结果。 

三、在设计中设置探针 

观察仿真结果的方法之一是在导线上设置一个探针或在设计中设置节

点，方法如下： 

1) 在 Schematic 窗口中，将光标移至 aout 导线并选择。该导线改变颜

色。 

2) 按下并保持鼠标右键来显示弹出菜单Wire  Menu。 

3) 在弹出菜单 Wire Menu 中，选择 Probe 条目并释放鼠标。显示

Probe窗口并附着在 aout 线上。此时单击 Zoom to Fit 图标 可

能是合益的。Probe 窗口的尺寸可以改变，把鼠标光标放到窗口的某

一角上单击并按住左键则可重新定位角的位置。同样若把光标放在窗

口的边上则可将 Probe 窗口在设计窗口中移动。 

4) 如果瞬态结果还没有显示在 Probe窗口中，你可按如下步骤装载一

个绘图文件： 

a 将光标移到 aout Probe窗口内。 
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b 按下并保持鼠标右键以显示上托 Probe Menu。 

c 在弹出菜单 Probe Menu中，选择 Open Plotfile⋯条目。会显示一

个 Open Plotfile对话框。 

d 在 File Name表中，选择 single_amp.tr。 

e 单击 OK键，在结果对话框中单击 Yes。输出波形显示在 Probe窗

口内。 

f  

 
图 18 

5) 按前面的步骤在输入信号(in)上设置探针。 

6) 从结果可以看出输出波形已被电路电容变圆滑。 

三、执行 AC分析和调用 Saber Scope 

在教材的这一部分，你将完成小信号频率分析以检查放大器的频率响应和

增益。另外，你还要调用 Saber Scope。 

1) 通过单击 Frequency Response图符 调出 Small-Signal 

Frequency Analysis对话框。会显示出 Basic表格。 

2) 如下填写表格： 

Start Frequency  100(默认单位赫兹) 

End Frequency  10 meg 

3) 单击 Input/ Output标签。 

4) 在 Plot After Analysis字段，单击 Yes键。 

5) 不要改动其他字段，单击 OK。AC分析的执行时间在 Saber Guide 

Transcript窗口中记录。并创建一个带扩展名.ac的文件来保存分析

结果。 

在 Saber Guide Transcript窗口中记录的最后一个动作是由步骤 3～5引起的

调用 Saber Scope。Saber Scope窗口与 Signal Manager窗口和 Single_amp.ac Plot 
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File窗口一起显示。从 Plot File窗口，你可选择并调出感兴趣的信号，如下节所

述。 

五、用 Saber Scope分析波形 

在瞬态和 AC分析完成后，可用 Saber Scope Waveform Analyzer察看结

果。 

1) 为除去屏幕的混杂信号，要将 Saber Sketch窗口最小化。 

2) 在 Single_amp.ac Plot File窗口中，左击选择信号 aout。该信号被

加亮。 

3) 在 Plot File窗口中单击 Plot按键或将光标移至 Graph窗口并单击鼠

标中键可在 Graph上绘出所选择的信号。aout波形显示在 Graph窗

口中。 

 
图 19 

4) 在本教材中你不需要 phase(deg):f(Hz)波形。按以下方法将其从

Graph窗口删去： 

a 将光标移至与 phase(deg).f(Hz)绘图关联的 aout信号名。aout信号

名和波形会改变颜色。 

b 按下并保持鼠标右键以调出 Signal Menu。 

c 选择 Delete Signal条目。 

5. 尽管你已经看到了瞬态分析的结果，但执行下列步骤可看出怎样在

Graph窗口调出另外的波形： 
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1) 在 Signal Manager对话框中，单击 Open Plotfiles⋯按钮。Open 

Plotfiles对话框出现。 

2) 在 File Name表中，单击 Single_amp.tr。 

3) 单击 OK按键，会显示 Single_amp.tr Plot File窗口。 

4) 从 Single_amp.tr Plot File窗口，调出 aout和 in信号，如前面第 2

和第 3步一样。图形窗口便会增加两个新波形。 

5) 注意 in和 aout波形的（V）：t(s)绘图与 Saber Sketch中设计所显

示的是一致的。当你察看完以后要删除这些波形。 

6. 在 Graph窗口中观察 aout dB(v):f(Hz),（dB 是伏特而频率是赫兹） 

从波形可看出从 2000Hz 到 75kHz增益约为 10dB。本教材的下一个部分

将使用这个波形上使用 Measurement Tool来获得增益和频响的准确读数。 

六、对波形进行测量和计算 

Saber Scope 内的 Measurement Tool 提供了在波形上实施各种测量和计

算的方法。按以下方法检查单级放大器输出信号（aout）的带宽和增益： 

1. 关闭 Plot File窗口和 Signal Manager窗口。 

2. 在位于 Saber Scope 底部的 Tool Bar 中，单击 Measurement 图符

。出现 Measurement对话框。 

3. 选择 Band pass测量步骤如下： 

1) 将光标移至 Measurement字段的右侧，在向下箭头键上 按下并

保持鼠标左键。 

2) 将鼠标下移至 Frequency Domain菜单。 

3) 选择 Bandpass。简而言之，选择：Measurement＞Frequency 

Domain＞Bandpass菜单条目。 
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4) 由于在 Graph窗口只有一个信号，aout应出现在 Measurement对话

框的 Signal字段，如图 20所示。 

 

  图 20 

 

5) 如果想看显示在图上的 Topline和 offset的值（这些值用于带通计

算），则可点击透视 Reference Levels字段的右侧的可见指示器。 

6) 单击 Apply键。带宽显示在图上。 

4. 按以下方法选择 Gain Margin测量： 

1) 选择 Measurement＞Frequency Domain＞Gain Margin菜单条目。 

2) 单击 Apply键。增益裕度显示在图中。 

 

5. 如下使用 Measure Results对话框，可获得更多有关执行的每次测量的
信息；或是控制显示在 Graph窗口内的信息量： 

1) 在 Graph窗口中，将光标移至 aout信号名。 

2) 使用弹出菜单并选择 Signal Menu＞Measure Results⋯条目。会出

现 Measure Results对话框。 

3) 在 Measure Results对话框中，确保左列的 Bandpass被选中，如图

21所示。 
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图 21 

 

4) 注意在 Measure Results对话框右列中，执行带通测量可获得不同的
值。 

5) 点击各可见标识器以选择 Graph窗口要显示哪些值。 

a 当你已完成 Measure Results对话框的探索后，将其关闭。 

 

七、变化某参数 

在教材这一部分，你可将发射电阻（re）从 200Ω变化到 400Ω，每次增

加 20Ω：并分别在每个电阻值时进行三类分析：直流工作点分析，瞬态分析和

小信号分析。 

1. 将 Saber Scope窗口最小化并调出 SaberSketch窗口。 

2. 单击 Vary图符 ，会出现 Looping Commands对话框。 
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图 22 

3. 在 Looping Commands对话框中，单击 Vary键。出现 Parameter 

Sweep对话框。 

4. 如下填充 Parameter Sweep对话框： 

Parameter Name  r.re 使用原始名称（r）后接标识符 

（re）来指定参数。 

Variation Type  Step by 

From    200 使 Saber将电阻值从 200Ω 

To    400 改变至 400Ω，增量 20Ω 

By    20 

Units    你可以保持该字段为下划线（-） 

单击 Accept。 

5. 按下列方法确定在每个扫描参数值上进行哪种分析： 

1) 在 Looping Commands 对话框中，选择 Add Analysis＞Within 

Loop(s)＞Transient 菜单条目。在 Looping Commands 对话框中会

出现一个新按钮(tranalysis)。 

2) 单击 tranalysis。出现 Time-Domain Transient Analysis对话框。如

果你自从开始使用本教材以来尚未关闭过 Saber Sketch的话，可以

看到你以前输入的值。步骤 c-e示出怎样恢复以前保存的设定值。 

3) 要调用你以前保存的瞬态分析设定值的话，在 Time-Domain 

Transient Analysis对话框中单击 Defaults，会出现 set up for 

tranalysis对话框。 

4) 在 Tags表中选择 amp_tr。这是你以前保存的文件名。 
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注意保存的瞬态分析设定值规定在每次进行瞬态分析前要执行 DC工

作点。每个 re电阻值应计算出新的工作点。 

5) 在 set up for tranalysis对话框中，单击 Apply。 

6) 在 Time-Domain Transient Analysis对话框中，单击 Input/ Output

标签。 

7) 在 Plot File和 Data File字段，在现有的“tr”字符串前增加字符串

“vary_”从而变为“vary_tr”。 因为你规定不同的文件名，这种瞬

态循环的结果不会改写以前的绘图文件。 

8) 在 Time-Domain Transient Analysis对话框中，单击 Accept。 

9) 在 Looping Commands对话框中选择 AddAnalysis >Within loop(s) > 

Frequency Response菜单会在该对话框中出现一个新按钮

acannlysis。 

10)  单击 acanalysis。出现 Small-Signal Frequency Analysis对话框 。 

自从开始本教材以来如果未关闭 Saber Sketch，你可看到以前输入

的值。 

6. 在 Basic格式程序中，检查以下设定值。 

Start Frequency  100(Hz是默认单位) 

End Frequency  10 meg 

1) 单击 Input/ Output页签。 

2) 在 Plot File 和 Data File 字段中，在现有“ac”字符串前面增加

“vary_”字符串，从而读作“vary_ac”。这样为绘图和数据文件创

建了一个新的名字从而避免新结果改写现有文件。 

3) 在 Plot After Analysis字段，单击 No键。 

4) 在 Small-Signal Frequency Analysis对话框，单击 Accept。 

7. 在 Loopping Commands对话框中单击 OK，开始执行参数扫描。        

在 Saber Guide Transcript窗口中观察循环动作。在仿真完成后，你可

显示参数扫描的结果。 

8. 退出 Saber Sketch应用（File＞Exit）。可以选择退出时保存设计。 
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八、显示参数扫描结果 

在这一部分，你将装载由各种仿真产生的绘图文件并用 Saber Scope显示

出来。 

1. 调出 Saber Scope窗口。 

2. 在 Saber Scope图符条中，单击 Clear Graph图符 从而删除以前的

波形。 

3. 如果 single_amp.ac plot File窗口是开启的话，要将其关闭。 

4. 在 Signal Manager中，单击 Open Plot Files键，显示 Open Plot File

对话框。 

5. 在 Open Plot File 对 话 框 中 ， 单 击 single_amp.vary_ac 和

single_amp.vary_tr文件名。 

6. 单击 OK。 

7. 在 single_amp.vray_ac Plot File 窗口中，绘制 aout。该图是一个多成

员波形，表明改变 r.re电阻的效果。 

8. 从图中删除 phase(deg):f(Hz)波形。 

9. 在 single_amp.vary_tr Plot File窗口中，在与 aout信号相同的 X/Y轴上

绘制 aout和 in信号，步骤如下： 

1) 在 single_amp.vary_tr Plot File窗口中，选择 aout和 in信号。 

2) 将光标移至 Graph窗口并单击鼠标中键（Windows NT系统使用 2

键鼠标，同时击左、右键可获得相同的功能）。 

10. 以下方法可帮助处理显示的数据： 

1) 选择 dB(V):f(Hz)aout信号。 

2) 选择 Signal Menu＞Members⋯菜单条目会显示 Members Attributes

对话框。 

3) 单击 Hide All键。小信号分析的结果现在被隐藏。 

11. 现在你可按下列步骤观察多成员（V）：t(s)aout 信号： 

1) 选择（V）：t(s)aout信号。 

2) 选择 Signal Menu＞Members⋯菜单条目。Members Attributes对话

框显示 aout数据。 
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3)  单击 Hide All按钮。波形消失。 

4) 点击 Loop Highlight按钮 。图形贯穿每个波形循环，再次点击 Loop 

Highlight按钮循环停止。 

5) 用 Member Attributes对话框实验，从各种性能中选择满意结果。 

12. 从 Graph窗口删除（V）:t(s)aout和 in信号。 

Member Attributes对话框现在控制剩下的 DB(V):f(Hz)aout信号。 

13. 在 Member Attributes对话框中，单击 Show All Members按钮。 

14. 关闭 Member Attributes对话框。 
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第四章    电路仿真 

一、从 Saber Sketch中进入防真环境 

用 SaberSketch创建了一个可用于仿真的设计，您便可以进入 Saber 

Guide Simulation 环境对设计进行仿真。单击工具条上的 Show/Hide Saber 

Guide按钮或选择 View > Show Guide Iconbar，将会出现仿真工具条（如图

23）。 

 

 

图 23 

在此环境中，您可以对设计进行多种仿真分析。 

二、DC Operating Point Analysis (直流工作点分析) 

1. 概述 

此分析功能在于求解系统的静态工作点，为其他分析提供计算初始点。 

2. 仿真器设置 

单击 DC Operating Point 按钮（如图 23）或选择 Analysis > 

Operating Point > DC Operating Point选项即可打开 DC分析的仿真器（如

图 24）。 
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图 24 

执行 DC分析时无须设置仿真器参数，使用默认值即可。下面对仿真器常

用参数的含义及其设置方法作简要介绍： 

Monitor Progress 

进度监控。确定仿真器运行时显示的信息数量，缺省值为 0。显示的信息

可在单击 Simulation Trancript按钮调出的 SaberGuide Trancript窗口中观

察。可进行如下设置： 

-1：  显示仿真执行过程的简要信息与执行时间。 

0：  只显示执行时间。 

正整数（n）：将在每 n个时间步长（时间步长：仿真器运行时，两次分

析计算之间的间隔。）显示那一时刻的仿真时间、反复数量、时间步长、占用

CPU时间等信息。 

Sample Point Density 

仿真器对电路中的非线性模块做线性化处理时将其分为 n个线性段(n值为

此参数值的 2倍)，n越大，精度越高，但会降低仿真速度，最大可取 1k。 

如图 25所示： 
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图 25 

3. 示例 

打开前面设计的 d:\analogy_tutorial\amp\single_amp.ai_sch文件，如图

6，调出 DC分析的仿真器如图 24，单击“OK”按钮即可执行 DC分析。单击

Simulation Transcript按钮可调出 SaberGuide transcript窗口观察仿真执行情

况。 

三、Small-signal AC Analysis（交流小信号分析） 

1. 概述 

交流小信号用于检验系统的频域响应特性，可用 DC分析结果作为本分

析的工作点。 

2. 仿真器设置 

单击 Small Signal AC按钮（如图 23）或选择 Analyses > Frequency > 

Small Signal AC选项，打开交流分析的仿真器（如图 26）。 

Start Frequency 

扫描起始频率（fbegin）：作交流分析的频率下限。必须满足 fbegin > 0。 

End Frequency 

扫描终止频率(fend)：作交流分析时的频率下限。必须满足 fend > 0。 

Run DC Analysis First 

确定交流小信号分析之前是否进行直流工作点分析。如希望从静态工作点 

开始分析则选 Yes，如从零时刻开始，选择 No。 
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图 26 

 

Signal List 

信号列表：在此列表中加入您需要观察的信号。单击 Select按即可出现待 

选项菜单（如图 27） 

 

 
 

图 27 

常用选项意义如下： 

All Top Level Signals 

包含多层次模型的设计中所有顶层信号。 
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All Signals 

设计中所有的信号。 

Get Selected Signals 

按住 Ctrl键，用鼠标点击所有您需要观察的信号所在导线（点击后导线变

为绿色表示选中），然后在 Signal List中选中 Get Selected Signals选项，即

可对您需要的信号加入列表，并替代原有信号。 

Append Selected Signals 

按住 Ctrl键，用鼠标点击所有您需要观察的信号所在导线（点击后导线变

为绿色表示选中），然后在 Signal List中选中 Get Selected Signals选项，即

可对您需要的信号追加到列表，而并非替代原有信号。 

Browse Design 

允许您自己选择需要观察的信号，选中此项会出现所有信号列表，在其中

可选择多个您需要的信号。 

Include Signal Types 

信号类型：选择需要观察的是电压信号（Variables Only）、电流信号

（Through Variables Only）或兼而有之（All Variables）。 

Plot File 

仿真结果文件：保存在 Signal List选项中被选中信号的仿真结果数据信

息。 

Data File数据文件 

此数据文件中包含了原始仿真结果及每个步长的计算结果，会占用大量的

磁盘空间。如无特殊需要，可在 Data File 文本框中输入“_”，就不会生成数

据文件。 

Initial Point File 

分析起点文件：以此文件的内容为分析起点进行分析。通常可设为两个

值： 

dc: 以 DC分析结果做为交流小信号分析的起点。 

zero: 从零点开始。 

3. 示例 
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打开 d:\analogy_tutorial\amp\single_amp.ai_sch文件，如图 6。调出交

流小信号分析仿真器进行如下设置： 

Start Frequency  100（默认单位 Hz） 

End    100meg 

Monitor Progress  1000 

Sample Point Density  1k 

Data File          _ 

其余参数按默认值即可。 

单击 OK即可执行交流小信号分析。在信号线上单击右键，选择下拉菜单

中的 Probe选项，可观察此点的仿真波形，双击图形区域可以进入 Scope环境

对仿真结果进行观察和测量。仿真结果如下图 28所示： 

 

图 28 

四、Time-Domain Analysis（瞬态分析） 

1. 概述 

瞬态分析用于检验系统的时域特性，此分析通常从静态工作点开始。但对

于自激振荡电路应从零时刻开始。 

2. 仿真器设置 

单击 Transient按钮（如图 23）或选择 Analysis > Time Domain > 

Transient选项即可打开交流分析的仿真器（如图 29）。 

End Time 

瞬态分析的终止时间。 
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Time Step 

初始步长。前两次分析计算的时间间隔。您所设定的只是起始步长，起始

步长越小，仿真精度高。第一步计算完成后，仿真器会根据上一步运算结果，

自动选择下次步长。 

Start Time 

  仿真分析的起始时间。可使用缺省值。 

 

 

图 29 

Max Truncation Error 

最大截断误差：在分析过程中每次计算结果的舍入精度。这个参数对仿真

结果精度影响很大，甚至导致仿真不收敛。参数值越小，仿真精度越高，但参

数值过小会降低仿真速度。通常取 100u即可。 

3. 示例 

打开 d:\analoty_tutorial\amp\single_amp.ai_sch文件，如图 6。打开瞬态

分析仿真器进行如下设置： 

End Time   10u；   

Time Step   0.1u 

Monitor Progress  100 

Run DC Analysis First No ( 如前面未做 DC分析，此项选 Yes) 
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Data File   _ 

Max Truncation Error  100u 

Sample Point Density  1k 

其余参数按默认值即可。 

单击 OK执行瞬态分析。可通过 Simulation Trancript窗口观察瞬态分析执

行过程（如图 30）。 

 

 

图 30 

 
仿真结果如图 31所示： 

 
图 31 
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五、DC Transfer Analysis (直流扫描分析) 

1. 概述 

此分析允许独立电源按照指定规律变化，从而实现电路特性的规律性的

研究。直流扫描分析一般在 DC分析的基础上进行。 

2. 仿真器设置 

单击 DC Transfer按钮（如图 23）或选择 Analysis > Operating Point 

> DC Transfer选项即可打开交流分析的仿真器（如图 32）。 

 

 

图 32 

Independent Source 

在分析中被扫描的独立源。单击文本框右边的下箭头按钮，选择 Browse 

Design，将出现 Signal List窗口，选中进行扫描的独立源，单击 OK将之加入

到 Independent Source文本框中。 

Sweep Range 

扫描方式。因为独立源采用不同的值进行多次分析计算，所以要选择一种

方法来取得每次参与分析计算的独立源值。单击 Sweep Range选项右边的

按钮可以看到，能通过四种方式获取每次参与分析计算的独立源值。每种方式

对应不同的扫描数据输入格式。 

Step By：从起点开始以用户指定数据为固定步长递增。 

 



 42

数据输入格式： 

from 初始值 to 终止值 by 步长 

Linear Steps：由用户指定分析次数 m，仿真器根据下面的公式自动计算

第 i次进行分析的 

Vi =Vo +（i-1）（Vi – Vo）/ (m-1) 

参数值。 

数据输入格式： 

from 初始值 to 终止值 in 次数 

Log Steps：由用户指定分析次数 m，仿真器根据下面的公式自动计算第

i次进行分析的 

lgVi = lgVo + i*(lgVm – lgVo) / (m-1)     (从 Vo开始，i=1..m-1) 

参数值。 

数据输入格式： 

from 初始值 to 终止值 in 次数 Log Steps 

Set Values：由用户设定参与分析的参数值。 

数据输入格式：将指定数据添入文本框，数据之间以空格分开。 

3. 示例 

打开 d:\analogy_tutorial\amp\single_amp.ai_sch文件，作如下改动，如

图 33所示，将 cinh换成 r3(10k)。 

 

图 33 

调出直流扫描分析仿真器进行如下设置： 
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Independent Source:       sig_source 

Sweep Range:              Step By 

From    0     To      10      by     0.5 

Data File:                _(下划线) 

Monitor Progress         100 

Sample Point Density      1k 

其余参数按默认值即可。 

单击 OK执行分析。单击 Simulation Transcript按钮可调出 SaberGuide 

transcript窗口观察仿真执行情况。 仿真结果如图 34所示： 

 
图 34 

六、Monte Carlo Analysis（蒙特卡罗分析） 

1. 概述 

在模型参数值浮动范围内随机取样（取样点数目由用户设定），对所取的

参数值进行分析，检验器件参数在一定范围内浮动对输出的影响。蒙特卡罗分

析要与其他分析（如瞬态分析）结合进行。 

2. 仿真器设置 

单击 Monte Carlo按钮（如图 Fig 23）或选择 Analysis > Statistical > 

Monte Carlo选项打开构建分析结构的窗口 Looping Commands（如图 Fig 

35）。 
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Edit menu 

编辑菜单。当需要进行多重蒙特卡罗分析或蒙特卡罗分析与参数扫描分析

互相嵌套时，通过对改变 Edit menu的选项，可以控制 AddLoop、

AddAnalysis菜单中添加的分析加入到当前分析运行结构的位置。 

Add Loop menu 

添加循环菜单。通过菜单选项可以在现有分析结构上加入蒙特卡罗分析或

参数扫描分析循环。 

Add Analysis menu 

添加分析菜单。通过菜单选项可以在现有分析结构上加入各种分析。 

 

图 35 

除上述三个菜单选项外，利用分析按钮右侧的  按钮也可以调整分析结

构。如图 28，通过 mc下拉菜单中的选项可以改变 mc分析在整个分析结构中

的位置，如上移（Move Up）、下移（Move Down）、删除（Delete）等。 

单击 mc按钮打开蒙特卡罗分析仿真器（如图 36）。 

Runs 

运行分析操作的次数。 

Seed 

模型随机取样点获取方式。即选择如何确定扫描分析的起点。 
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图 36 

Parameter List 

参数列表。选择需要进行扫描的模型参数。单击 Select按钮将出现一个下

拉菜单（如图 37），为您提供了多种方式选择要进行扫描的参数。各种方式的

意义介绍如下： 

 

图 37 

All Toplevel Parameters 

选择带有多层次模型的设计中所有顶层模型参数进行扫描。 

All Parameters 

选择各层次模型的所有参数进行扫描 

Browse Design 

选中此项，将出现一个包含所有参数的列表框（如图 38），按住 Ctrl键，

点击所有需要进行扫描的参数，单击 OK按钮，即可将这些参数加入到 
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图 38 

Parameter List文本框中。 

Get Parameters From Selected Parts 

选中此项，将出现一个包含选中模型参数的列表框（如图 39），按住 Ctrl

键，点击所有需要进行扫描的参数，单击 OK按钮，即可将这些参数加入到

Parameter List文本框中，原有内容将被覆盖。 

Append Parameters From Selected Parts 

选中此项，将出现一个包含选中模型参数的列表框（如图 39），按住 Ctrl

键，点击所有需要进行扫描的参数，单击 OK按钮，即可将这些参数加入到

Parameter List文本框中，追加到原有内容。 

3. 示例 

 

图 39 
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按图 32绘制原理图，各模型参数设置如表二： 

表二 

模型名称 符 号 参 考 属性名 属性值 

ref v1 

initial 0 

pulse 1 

tr 1u 

tf 1u 

delay 10u 

width 50u 

period 100u 

v_pulse v.v1 

ac-mag 1 

ref r1 r.r1 

mom normal(100,0.1) 

ref R2 

Resistor 

r.r2 

mom uniform(1k,0.1) 

ref c1 Capacitor c.c1 

c normal(1u,0.1) 

ref l1 Inductor l.l1 

l normal(25m,0.1) 

 

将此文件保存为：d:\example\rlc。 

打开文件 d:\example\rlc.ai_dsn，在 mc分析内层添加直流工作点分析和

瞬态分析循环，对 Vary与 tr仿真器进行如下设置： 

瞬态分析仿真器： 

End Time：5m； 

Time Step: 10n 

Max Tranction Error：100u； 

Monitor Progress：100； 

Sample Point Density:1k 

Data File  : “_” 

mc分析仿真器： 
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runs:           20； 

seed:           constant； 

Parameter List: 利用前面介绍的方法选择 r.r1、r.r2、c.c1、l.l1； 

其余参数按默认值即可。 

单击 OK键执行仿真命令。仿真结果如图 40所示： 

 

 
图 40 

七、Pole-Zero Analysis (零极点分析) 

1. 概述 

此分析用于求解交流小信号电路传递函数中极点和零点的个数及其数值。

做零极点分析之前应先做直流工作点分析。 

2. 仿真器设置 

单击 Pole-Zero按钮（如图 23）或选择 Analysis > Linear System 

Analysis >Pole-Zero 选项打开 pz分析仿真器设置窗口（如图 41） 
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图 41 

Find Poles、Find Zeros 

选择寻找零点还是极点。 

Input Source 

选择独立源。 

Output List 

选择输出信号。 

(3)、示例 

打开文件 d:\example\rlc.ai_dsn，调出 pz分析仿真器，参数设置如下： 

Find Zeros：         Yes 

Input Source：        v_pulse.v1 

Output List：         vout 

Run DC Analysis First：Yes（如事先以做过直流工作点分析，此项可选

No）。 

Report After Analysis: Yes 

其余参数按默认值即可。 

单击 OK按钮执行 pz分析。分析结果如图 42所示： 
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图 42 

也可以在 SaberScope中观察仿真结果，选择 Results > View Plotfiles in 

Scope可自动调出 SaberScope显示仿真结果： 

 

 
图 43 

八、Parameter Sweep Analysis (参数扫描分析) 

1. 概述 

此分析用于检测电路中某个元件的参数，在一定取值范围内变化时对电路

直流工作点、时域特性、频域特性的影响。 

2. 仿真器设置 

单击 Vary按钮（如图 23）或选择 Analysis > Parametric > Vary选项打开

构建分析结构的窗口 Looping Commands（如图 44）。 

构建分析结构的方法与前面介绍的蒙特卡罗分析中相同。此处不再重复介

绍。单击 Vary按钮可进入参数扫描分析仿真器设置环境（如图 45）。 
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图 44 

 

 

图 45 

Parameter Name 

选择要进行扫描的参数。单击 Select按钮将出现一下拉菜单（如图 45）

各选项意义： 

Browse Design 

选中此项时，会调出一个参数列表框，其中包括了所有模型的参数，可在

其中选取需要进行扫描分析的参数。 

Get Parameters from Selected Parts：选中此项也会调出一个参数列表

框，不同之处在于，这里只包括在设计中被选中模型的参数。 

Variation Type 

参数值获取方式。由于参数扫描分析是在一定范围内进行多次分析，所以

如何确定每次分析采用的参数值需要根据用户的要求来设定（蒙特卡罗分析中

每次分析使用的参数值由仿真器随机指定，这正是二者区别所在）。单击



 52

Variation Type选项右边的 按钮可以看到，能通过四种方式获取每次分析的参

数值。 

Step By 

从起点开始以用户指定数据为固定步长递增。 

数据输入格式： 

     from    初始值     to   终止值    by    步长 

Linear  

由用户指定分析次数 m，仿真器根据下面的公式自动计算 

Ni =No +（m-1）（Nm – No）/ m 

每次进行分析的参数值。 

数据输入格式： 

     from    初始值     to   终止值    in    次数 

Log Steps 

由用户指定分析次数 m，仿真器根据下面的公式自动计算每次进行 

       lgNi = lgNo + i*( lg Nm – lgNo）/ (m-1)  (从 No开始，i=1..m-1) 

分析的参数值。 

数据输入格式： 

     from    初始值     to   终止值    in      次数       Log Steps 

Set Values：由用户设定参与分析的参数值。 

数据输入格式：将指定数据添入文本框即可。 

(3)、示例 

打开文件 d:\example\rlc.ai_dsn，在 Vary分析内层添加零极点分析，对 

Vary与 pz仿真器进行如下设置： 

pz分析仿真器： 

Find Zeros：         Yes 

Input Source：        v_pulse.v1 

Output List：         vout 

Run DC Analysis First：Yes（如事先以做过直流工作点分析，此项可选

No。） 

Report After Analysis: Yes 
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其余参数按默认值即可。 

Vary分析仿真器： 

        Parameter Name: /c.c1/c 

    From   0.1u    To    1u    by   0.1u 

其余参数按默认值即可。 

添加 AddAnalysis > After Loops > View Plotfiles in Scope菜单项，以便

在完成分析后自动显示结果。 

单击 OK键执行仿真命令。 

仿真结果如图 46所示： 

 

 
图 46 

九、Fourier Analysis For Periodic Signals (傅立叶分析). 

1. 概述 

此分析用于求解时域信号的直流分量、基波分量高次谐波分量的幅度和相

位。傅立叶分析必须以瞬态分析为基础。 
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图 47 

2. 仿真器设置 

选择 Analyses > Fourier >Fourier选项即可打开傅立叶分析的仿真器（如

图 40）。通常进行傅立叶分析时，仿真器参数按其默认值即可。也可以根据自

己的需求进行参数设定，如改变需要计算的谐波数量(Number of Harmonics)、

傅立叶变换的基频（Fundamental Frequency）、起点和终点（Period 

Beginning, Period End）等。 

3. 示例 

按图 48绘制仿真原理图。 
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图 48 

 

各模型参数见表三： 

表三 

模型名称 符 号 参 考 属性名 属性值 

ref vcc 
v_pulse v.v1 dc_value 30 

ref vin 

offset 0 

amplitude 5 
V_sin v.vin 

frequency 100 

ref q1 

Saber_model (type=_n,bf=150,is

=3e-

12,rb=2,rc=100m,r

e=50m,cje=1n,cjc=

500p,ikf=3,br=5) 

q_3p,npn q.q1 

ratings (pdmax_ja=20,icm

ax=5,vcemax=50) 

ref X1 Winding,li

near2 

Xfr.x1 

Lp=400m,ls=100m,Ur==1,k=0.995, 

rp=100m,rs=50m 
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  Ratings:pdmax_ja=30,vpmax=40, 

vsmax=20,ipmax=5,ismax=20 

r.r1 ref:r1,rnom:1k 

r.r2 ref:r2,rnom:220 

r.rsrc ref:rsrc,rnom:100 
Resistor 

r.rload ref:rload,rnom:8 

Capacitor c.cin ref:cin,c:100u 

c_pdmax 1 

c_max 50 Saber  

c_vrmax 5 

 

将此文件保存为：d:\example\pwramp。 

首先对此电路做直流工作点分析和瞬态分析。 

瞬态分析参数设置： 

End Time :    100m 

Time Step:    1u 

Monitor Progress: 100 

Run DC Analysis First: Yes 

Plot After Analysis: Yes – Open Only 

Max Truncation Error (under Calibration): 100u 

单击 OK执行 DC分析与瞬态分析。 

打开傅立叶分析仿真器进行如下设置： 

   Number of harmonics: 14 

   Fundamental Frequency: 100 

   Plot After Analysis:  Yes – Open Only 

   单击 OK执行傅立叶分析。分析结束后将自动调出 SaberScope，在

pwramp.fou信号窗口中双击 rload观察傅立叶分析结果（如图）。在图形窗口

右上角处的 roald字符串单击右键，会弹出一个下拉菜单，选择 View > Vertical 

value > dB(y) 选项，将仿真结果转化为 Bode图（如图 49）。 
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图 49 

十一、Stress Analysis (应力分析) 

1. 概述 

应力分析用来检验电路运行时的工作参数是否超过的元器件的承受能力。 

2. 仿真器设置 

选择 Analysis > Stress选项打开应力分析的仿真器（如图 50）。 

 

 

图 50 
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Use Input From 

选择电路工作参数的来源。可以是静态工作点、瞬态分析结果或初始状

态。 

Input Data File 

选择电路工作参数文件。与电路工作参数来源相对应。 

Use Input From：Transient Analysis——  Input Data File：tr 

Use Input From：Initial Point File——  Input Data File：_ 

Use Input From：DT Transfer Analysis——  Input Data File：dt 

3. 示例。 

打开文件 d:\example\pwramp.ai_dsn，在做应力分析之前，请先进行 DC

分析和瞬态分析， 

瞬态分析参数设置： 

End Time :    50m 

Time Step:    1u 

Monitor Progress: 100 

Run DC Analysis First: Yes 

Max Truncation Error (under Calibration): 100u 

单击 OK执行 DC分析与瞬态分析。 

然后对 Stress仿真器进行如下设置： 

Use Input from:   Transient Analysis 

Report After Analysis: Yes 

Derating File Name: derating.file 

X window:  10m 

其余参数按默认值即可。 

单击 OK按键运行应力分析。分析结果如图 51： 
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图 51 

 

十一、Sensitivity Analysis(灵敏度分析) 

1. 概述 

此分析用来检验某个模型参数发生变化时，对系统特性的影响。 

2. 仿真器设置 

选择 Analysis > Parametric>Sensitivity选项打开应力分析的仿真器（如图

53）。 

Parameter List 

要进行灵敏度分析的参数列表。单击 Select按钮将出现一个下拉菜单。各

菜单选项意义如下： 

All Parameters 

选择所有模型的所有参数进行扫描 
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Browse Design 

选中此项，将出现一个包含所有参数的列表框（如图 52），按住 Ctrl键，

点击所有需要进行扫描的参数，单击 OK 按钮，即可将这些参数加入到

Parameter List文本框中。 

 

图 52 

Get Parameters From Selected Parts 

选中此项，将出现一个包含选中模型参数的列表框（如图 52），按住 Ctrl

键，点击所有需要进行扫描的参数，单击 OK按钮，即可将这些参数加入到

Parameter List文本框中，原有内容将被覆盖。 

Append Parameters From Selected Parts 

选中此项，将出现一个包含选中模型参数的列表框（如图 52），按住 Ctrl

键，点击所有需要进行扫描的参数，单击 OK按钮，即可将这些参数加入到

Parameter List文本框中，追加到原有内容。 

Perturbation 

参数值相对误差。 
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图 53 

3. 示例 

打开文件 d:\example\rlc.ai_dsn，调出灵敏度分析仿真器，参数设置如

下： 

Parameter List   r.r1/rnom r.r2/rnom c.c1/c l.l1/l 

Perturbation   0.1 

Report After Analysis  Yes 

选择 Addanalysis > Basic > Transient选项添加一瞬态分析。其参数设

置： 

End Time   5m 

Time Step   10n 

Monitor Progress  100 

Run DC Analysis First Yes 

Max Truncation Error (under Calibration) 100u 

单击 Accept。 

选择 Addanalysis > Batch Measure选项，添加一测量操作，其参数设

置： 

Measure Time Domain > Overshoot 

Curve Name Vout 

单击 Accept。 

单击 OK按钮运行灵敏度分析。可从 SaberGuide Trancript窗口中观察分

析结果（如图 54） 
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图 54 

十二、Two-Port Analysis (两端口分析) 

1. 概述 

此分析用于计算输入输出阻抗以及直流工作点附近的小信号传递函数等。 

2. 仿真器设置 

选择菜单 Analyses > Frequency > Two-Port选项可以打开两端口分析的

仿真器（如图 55）。各参数意义： 

 

 
Strart Frequency 

起始频率。 
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End Frequency 

终止频率。 

Input Source 

输入电源，必须是独立源。 

Output Port 

输出变量对应的节点。 

3. 示例 

打开文件 d:\example\pwramp.ai_dsn，将 rsrc.rnom(如图 48中红圈标注)

改为 1m,在做两端口分析之前，请先进行 DC分析。 

两端口分析仿真器参数设置： 

Start Frequency: 10 

End Frequency: 1k 

Input Source: v_sin.vin 

Output Ports: vload 

Plot After Analysis: Yes-Open Only 

单击 OK运行两端口分析。 

分析完成后，SaberScope、Signal Manager、信号图形窗口将被自动调

出，在信号图形窗口中双击+v_sin.vin, vload目录，在子菜单中双击 gain选项

（放大倍数）与 zin选项(输入)，观察分析结果（如图 56）。 

 

 
图 56 
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第五章    如何创建 Symbol 
 

我们在用 Saber仿真软件进行设计时，有时现有 model的 symbol不能满

足我们的需要(如变压器的输入输出端口的结构)；或者我们想把自己的某个模

块做成一个 model，以便在以后的设计中调用，实现真正的 Top-down 结构；

或者我们想自己建模等，在这些情况下，我们都会用到 Symbol 的创建。在这

一章里，我们将具体介绍如何来创建自己的 Symbol。 

 

一、通过修改现有的 Symbol 

我们在使用变压器或 Ic芯片时，有时需要改变变压器输入输出端的结构

或者芯片管脚的位置，在这种情况下，我们只需修改现有 Symbol。 

具体操作是从 SaberSketch中打开现有的 Symbol(打开的方法有很多，可

以直接从 File下打开，也可以从 Parts Gallery 中找到这个 Model,把它放入原

理图，然后用鼠标点左键点击它，再点击右键打开 Symbol Menu,选中 Symbol 

Editor项)，修改后保存在相应的文件目录下（如图 57）。 

 
图 57 

如果你想以后方便使用的话，你还可以把它做成一个新的 Model，方法如

下： 

第一步：从 SaberSketch界面中打开 Parts Gallery->Edit->New Parts 
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第二步：在 Create New Part 对话框的 description栏中填上 Model名(你 

自己任意取)，Category栏中选取 Model的路径，Symbol栏中选取你前面保存

过的 Symbol,然后按 Create键 

第三步：如果你要给这个 Model编写自己的 Mast语言，你还必须在 Create 

New Part 对话框的属性栏中填上必要的属性。最只要的是在第一栏属性框的

Name中填上 primitive, Value中填上你所写 Mast语言的文件名，如图 58所

示： 

 
图 58 

二、创建 Hierarchical Symbol  

Hierarchical Symbol就是我们通常所说的层级符号，创建 Hierarchical 

Symbol 的目的是把我们常用的子模块电路做成自己的元器件 Model, 方便以后

使用，实现真正的 Top-down设计。我们用前面创建的 Single_amp文件为例

讲述创建 Hierarchical Symbol的过程。 

第一步：首先打开 Single_amp原理图，去掉直流电源 v_dc(假设此直流电

源是由其它模块提供)，再假设晶体三极管的发射极为输出端，为其它模块提供

电信号，然后它的输入输出端加上 connector(在 saber Model里有多种

connector, 由于此处是模拟层级接口，所以选用 Hierarchical analog Model) ， 

并分别为它们取名 a、b，如图 59所示： 
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图 59 

 

第二步：从 SaberSketch的下拉菜单中选上 Schematic->Create-> 

Hierarchical Symbol, 如图 60所示。 

 
图 60 

第三步：完成第二步以后，会出现绘制 Symbol的窗口（如图 61），而

且里面存在了你在原理图上加上的 a、b两个 connector，你可以在它们之间绘

上你所喜欢图形，然后 Save就可以了。 
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图 61 

如果你要把它建成一个 Model，你可以照 1中所讲的步骤完成。 

 

下面是一个用磁路结构创建变压器的例子： 

一．设计变压器初级绕组 
 

1.由于印制板基材内径为 9mm，线宽为 0.3mm，线间距为 0.3mm, 而且

初级绕组共 8层，每层 3匝， 所以可以算出从里到外第一匝的面积为

67.9mm2 , 第二匝的面积为 83mm2, 第三匝的面积为 103.8 mm2 。 

2.由于 8层绕组之间都是串联，所以整个初级线圈可以看成是 8匝面积为

67.9mm2、8匝面积为 83mm2以及 8匝面积为 103.8 mm2的线圈串联而成。 

3.绕组层与层之间有电容，估计为 50P。 

根据以上三点，设计出初级绕组如图 62所示： 

 
                       图 62 
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二、设计变压器次级绕组 
 
1. 由于印制板基材内径为 9mm，线宽为 0.2mm，线间距为 0.2mm, 而且

初级绕组共 24层，每层 5匝， 所以可以算出从里到外第一匝的面积为

66.4mm2 , 第二匝的面积为 78.5mm2, 第三匝的面积为 91.56m m2 ，第四匝的

面积为 105.6mm2,第五匝的面积为 120.7mm2。 

2.由于 8层绕组之间都是串联，所以整个初级线圈可以看成是 24匝面积

为 66.4mm2、24匝面积为 78.5mm2、24匝面积为 91.56mm2、24匝面积为

105.6mm2以及 24匝面积为 120.7mm2的线圈串联而成。 

3.绕组层与层之间有电容，估计为 10P。 

根据以上三点，设计出初级绕组如图 63所示： 

 

 
                   图 63 

 
 

三、封装初级与次级绕组 

初级绕组封装和次级绕组封装如图 64所示： 

 
图 64 
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四、设计磁芯并组成完整的变压器 
 

1、磁芯型号为 RM8,磁导率 u =2000,可查得： 

uhc =10000,bmax=4200,hmax=15,bsat=3800,hsat=3.5,br=1750,hc=0.25 

2、由磁芯的形状，可以把它看成双 E型磁芯，根据它的外形尺寸，可

以得到它的磁芯长度和面积以及气隙长度。得到初级绕组、次级绕组和磁芯尺

寸和外形后，通过 Saber的磁路结构法构造出平面脉冲变压器的结构如图 65

所示： 

 
 

 
     图 65 

 
五、封装变压器 
 

变压器的封装图如图 66所示: 

 
图 66 

然后按前面介绍的方法把它做成 model。 
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附录一 

List of Measurement Operations 

   

The following list identifies the measurements that are available through the 
Measurement Tool: 

Measurement 
 

Category 
 

Description 
 

AC Coupled RMS  
 

Levels 
 

Displays the RMS value of the AC component of 
a waveform. 

 
Amplitude  
 

Levels 
 

Displays the amplitude of a waveform. 
 

At X    
 

General 
 

Displays the Y-axis value at a particular X-axis 
point on a waveform. 

 
Average  
 

Levels 
 

Displays the average value of a waveform. 
 

Bandpass  
 

Frequency 
Domain 

 

Displays the bandwidth, the low, high, or center 
frequency, or the level at which the measurement 
is made for a bandpass-shaped waveform. 

 
Baseline  
 

Levels 
 

Displays the baseline level of a waveform. 
 

Cpk  
 

Statistics 
 

Displays an indicator of the process capability for 
a waveform. 

 
Crossing  
 

General 
 

Displays the crossing (intersection) points of two 
waveforms. 

 
Damping Ratio  
 

s Domain 
 

Displays the damping ratio of a point on a 
waveform. 

 
dB  
 

Frequency 
Domain 

 

Displays the dB value on a point on a waveform.
 

Delay  
 

Time Domain 
 

Displays the delay between the edges of two 
waveforms. 
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Delta X  
 

General 
 

Displays the X-value difference between two Y-
axis points on one or two waveforms. 

 
Delta Y  
 

General 
 

Displays the Y-value difference between two X-
axis points on one or two waveforms. 

 
Dpu  
 

Statistics 
 

Displays the number of defects per unit of a 
scatter plot waveform. 

 
Duty Cycle  
 

Time Domain 
 

Displays the duty cycle of a periodic waveform.
 

Falltime  
 

Time Domain 
 

Displays the falltime of a waveform. 
 

Frequency  
 

Time Domain 
 

Displays the frequency of a periodic waveform. 
 

Gain Margin  
 

Frequency 
Domain 

 

Displays the gain margin in dB of a complex 
waveform. 

 
Highpass  
 

Frequency 
Domain 

 

Displays the corner frequency of a waveform 
with a highpass shape. 

 
Histogram  
 

Statistics 
 

Displays a histogram of a waveform. 
 

Horizontal Level  
 

General 
 

Displays a moveable horizontal line to identify 
Y-axis levels. 

 
Imaginary  
 

Frequency 
Domain 

 

Displays the imaginary value of a point on a 
waveform. 

 
Length  
 

General 
 

Displays the length of a straight line that 
connects two X-axis points on a waveform. 

 
Local Max/Min   
 

General 
 

Displays the local maximum or minimum point 
on a waveform. 

 
Lowpass  
 

Frequency 
Domain 

 

Displays the corner frequency of a waveform 
with a lowpass shape. 

 
Magnitude  
 

Frequency 
Domain 

 

Displays the magnitude of a point on a 
waveform. 

 
Maximum  
 

Levels and 
Statistics 

 

Displays the maximum value of a waveform. 
 

Mean  
 

Statistics 
 

Displays the mean value of a waveform. 
 

Mean +3 std_dev  
 

Statistics 
 

Displays the (mean + 3σ) value of a waveform. 
 

Mean -3 std_dev  
 

Statistics 
 

Displays the (mean -3σ) value of a waveform. 
 

Median  Statistics Displays the median value of a waveform. 
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Minimum   
 

Levels and 
Statistics 

 

Displays the minimum value of a waveform. 
 

Natural Frequency 
顯示的文字不能跨

   
 

s Domain 
 

Displays the natural frequency of a point on a 
waveform. 

 

Nyquist Plot 
Frequency   
 

Frequency 
Domain 

 

Displays the frequency at a point on a Nyquist 
(or Nichols) plot. 

 
Overshoot  
 

Time Domain 
 

Displays the overshoot of a waveform relative to 
a default or specified topline. 

 
Pareto  
 

Statistics 
 

Displays a Pareto chart of a multi-member 
analysis. 

 
Peak to Peak 
 

Levels 
 

Displays the waveform's peak-to-peak value. 
 

Period  
 

Time Domain 
 

Displays the period of a periodic waveform. 
 

Phase 
顯示的文字不能跨

   
 

Frequency 
Domain 

 

Displays the phase value on a point on a 
waveform. 

 

Phase Margin   
 

Frequency 
Domain 

 

Displays the phase margin of a complex 
waveform in degrees or radians. 

 
Point Marker  
 

General 
 

Displays a moveable point marker on the 
waveform to display the X-value and Y-value. 

 
Pulse Width  
 

Time Domain 
 

Displays the pulse width of a waveform. 
 

Quality Factor   
 

s Domain 
 

Displays the quality factor of a point on a 
waveform. 

 
Range  
 

Statistics 
 

Displays the range of Y-axis values covered by 
the waveform. 

 
Real  
 

Frequency 
Domain 

 

Displays the real value of a point on a waveform.
 

Risetime  
 

Time Domain 
 

Displays the risetime of a waveform. 
 

RMS   
 

Levels 
 

Displays the RMS value of a waveform. 
 

Settle Time  
 

Time Domain 
 

Displays the settle time of a waveform. 
 

Slew Rate  
 

Time Domain 
 

Displays the slew rate of a waveform. 
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Slope  
 

Frequency 
Domain and 
General 

 

Displays the slope (optionally as a per-octave or 
per-decade value) of a waveform. 

 

Standard 
Deviation  
 

Statistics 
 

Displays the standard deviation of a waveform. 
 

Stopband  
 

Frequency 
Domain 

 

Displays the stopband, the low, high, or center 
frequency, or the level at which the measurement 
is made for a stopband-shaped waveform.  

 
Threshold (at Y)   
 

General 
 

Displays the X-axis values at a particular Y-value 
on the waveform. 

 
Topline  
 

Levels 
 

Displays the topline level of a waveform. 
 

Undershoot   
 

Time Domain 
 

Displays the undershoot of a waveform. 
 

Vertical   
 

General 
 

Displays a moveable vertical line to identify X-
axis levels. 

 
Vertical Cursor   
 

General 
 

Displays a vertical cursor that spans different 
graphs, for X-value, Y-value, and delta Y 
measurements. 

 
X at Maximum  
 

Levels 
 

Displays the X-value corresponding to the 
maximum value of a waveform. 

 
X at Minimum  
 

Levels 
 

Displays the X-value corresponding to the 
minimum value of a waveform. 

 
Yield  
 

Statistics 
 

Displays the ratio of data points that fall between 
the specified upper and lower Y-axis values of a 
waveform. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 74

 
 
 
 
 
 
 
 
 
 

附录二 
 

Calculator Extended Operation Buttons 

   

Misc Button  
 

Performs various mathematical operations as well as 
vector and matrix array operations. 
 

vma Menu  
 

Performs vector, matrix, and array operations. This 
menu is selected from Misc button options. 
 

Wave Button  
 

Performs waveform operations. 
 

Cmplx Button  
 

Performs complex number operations. 
 

Logic Button  
 

Performs logical operations. 
 

Trig Button  
 

Performs trigonometric operations. 
 

Stack Button  
 

Manages the stack registers. 
 

 

Misc Button 

Operation 
 

Description 
 

abs 
 

The absolute value of the X-register. 
 

mod 
 

x modulo y. 
 

fmod 
 

Floating point x modulo y. 
 

ceil 
 

Rounds off floating point values to the next highest integer. 
 

floor Rounds off floating point values to the next lowest integer. 
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round 
 

Rounds off floating point values. 
 

hypot 
 

The square root of the sum of the square of the X-register and 
the square of the Y-register. 

 
vma 
 

Opens Vector/Matrix/Array menu. 
 

 

VMA Menu 

 
 

Wave Button 

Operation 
 

Description 
 

FFT 
 

Opens the Fast Fourier Transform dialog box. 
 

IFFT Opens the Inverse Fast Fourier Transform dialog box. 

Operation 
 

Description 
 

vmax 
 

Returns the largest value of all of the elements in a vma 
argument. 

 
vmaxi 
 

Returns the index for the largest value of all of the 
elements in a vma argument. 

 
vmin 
 

Returns the smallest value of all of the elements in a vma 
argument. 

 
vmini 
 

Returns the index for the smallest value of all of the 
elements in a vma argument. 

 
mean 
 

Returns the mean value of all of the elements in a vma 
argument. 

 
sum 
 

Returns the sum of all of the elements in a vma 
argument. 

 
var 
 

Returns the computed sample variance of all the 
elements in a vma argument. 

 
variance 
 

Returns the biased variance of all the elements in the 
vma argument. 

 
specvariance 
 

Returns the spectral variance of all the elements in a 
vector vma argument. The argument is assumed to be 
the result of a Fourier transform. 
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Swap X and Y Axes 
 

Swaps the x and y axes of the waveform in the X-register.
 

Limit X Range 
 

Limits the range of the x axis of the waveform in the X-
register. 

 
Limit X and Y Range 
 

Limits the range of the x and/or y axes of the waveform in 
the X-register. 

 
Limit to Finite Values 
 

Limits the range of the x and/or y axes of the waveform to 
finite values. 

 
Change X and Y View 
 

Applies a view transform to the x and/or y axes of the 
waveform in the X-register 

 
Sample X Axis 
 

Applies X-sampling to the waveform in the X-register. 
 

f(x) 
 

Creates a parametric function of y1 vs y2, with X as the 
parameter for waveforms in the X-register and Y-register. 

 
Histogram 
 

Converts the waveform in the X-register to a histogram. 
 

Extract Member 
 

Extracts a single member from a multi-member 
waveform in the X-register. 

 
Swap Parameters 
 

Swaps the waveform parameter order of the waveform in 
the X-register. 

 
Reduce Dimension 
 

Reduces the dimension of the waveform in the X-register 
by 1. 

 
Group Delay 
 

Creates a new waveform displaying Group Delay time. 
 

Phase Delay 
 

Creates a new waveform displaying Phase Delay time. 
 

 

Cmplx Button 

Operation 
 

Description 
 

J 
 

Places a "j" onto the X-register to indicate a complex 
number. 

 
complex 
 

Creates a complex number with the X-register as the real 
part, and the y register as the imaginary part. 

 
real 
 

Places the real part of a number or waveform onto the X-
register. 

 
imag Places the imaginary part of a number or waveform onto 
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 the X-register. 
 

mag 
 

Absolute magnitude. 
 

db 
 

Decibels. 
 

phase 
 

Phase of the X-register, always in radians, limited to 
values between 0 and 2π. 

 
cphase 
 

Phase of the X-register, always in radians, with unlimited 
bounds. 

 
phasedeg 
 

Phase of the X-register, always in degrees, limited to 
values between 0 and 360. 

 
cphasedeg 
 

Phase of the X-register, always in degrees, with unlimited 
bounds. 

 
conjugate 
 

Complex conjugate of the X-register. 
 

polar 
 

Converts polar notation to a complex number. 
 

 

Logic Button 

Operation 
 

Description 
 

y or x 
 

 OR the X and Y-registers (bitwise operation). 
 

y and x 
 

AND the X and Y-registers (bitwise operation). 
 

y xor x 
 

Exclusive OR the X and Y-registers (bitwise operation). 
 

not x 
 

NOT the X-register (bitwise operation). 
 

y<<x 
 

Left shift the Y-register by the number of bits in the X-
register. 

 
y>>x 
 

Right shift the Y-register by the number of bits in the X-
register. 

 
y<x 
 

The X-register is set to 0 if the X-register is less than the 
Y-register. Otherwise, it is set to 1. 

 
y<=x 
 

The X-register is set to 0 if the X-register is less than or 
equal to the Y-register. Otherwise, it is set to 1. 

 
y>x 
 

The X-register is set to 0 if the X-register is greater than 
the Y-register. Otherwise, it is set to 1. 
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y>=x 
 

The X-register is set to 0 if the X-register is greater than 
or equal to the Y-register. Otherwise, it is set to 1. 

 

 

Trig 

Operation 
 

Description 
 

sin 
 

Sine of the X-register. 
 

cos 
 

Cosine of the X-register. 
 

tan 
 

Tangent of the X-register. 
 

asin 
 

Inverse sine of the X-register. 
 

acos 
 

Inverse cosine of the X-register. 
 

atan 
 

Inverse tangent of the X-register. 
 

atan2 
 

Inverse tangent of the X-register divided by the Y-
register. 

 
sinh 
 

Hyperbolic sine of the X-register. 
 

cosh 
 

Hyperbolic cosine of the X-register. 
 

tanh 
 

Hyperbolic tangent of the X-register. 
 

 

Stack 

Operation 
 

Description 
 

Clear All 
 

Clear all registers. 
 

Clear Selected 
 

Clear selected stack registers. 
 

Clear X 
 

Clear the first stack register. 
 

Rename X 
 

Rename the item in the X-register 
 

Copy X 
 

Copy waveform in the X-register. Specify new axis names 
and units of scale. 

 
Swap X and Y 
 

Swap the first two stack registers. 
 

Roll Up 
 

Roll the stack up one register. 
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Roll Down 
 

Roll the stack down one register. 
 

 
 


